END USER WARRANTY

EGO SYSTEMS, INC. warrants the return policy to its original purchaser as follows: All EGO
SYSTEMS INC.’s products, under normal use, will be free from fault as long as the purchaser
owns this product for a period of twelve (12) months from the date of purchase.

EGO SYSTEMS INC. will, at its sole option, repair or replace a product, which is found to be
defective. This warranty shall be invalid if, in the sole opinion of EGO SYSTEMS INC., a product
failure is the result of misuse, abuse, modification, or misapplication. Except as expressly
provided above, EGO SYSTEMS INC. products are provided, ‘as is' without any kind of warranty.
No claim is made for merchantability or fitness for any purpose. In no event will EGO SYSTEMS
INC. be liable for any direct, indirect, consequential, or incidental damages arising out of use
of the product.

The purchaser must contact EGO SYSTEMS INC. or its regional representative to receive prior
approval before returning a faulty unit.

To obtain warranty service, the buyer or his authorized dealer must send an email to
techsupport@audiotrak.net before returning the product. EGO SYSTEMS INC. will then issue an
authorization number.

All such returns must be shipped to EGO SYSTEMS INC. headquarters in Seoul, Korea or the U.S,
packaged in the original or equivalent protective packaging material (rack, PCI card, power
cables, connection cables), with freight prepaid and adequate insurance. Any shipments
without freight prepaid will not be accepted. If the returned product is deemed to be defective,
the repaired or replacement product will be returned at no extra charge via the carrier chosen
by EGO SYSTEMS INC.

Trademarks

AUDIOTRAK and MAYA7.1 are trademarks of EGO SYSTEMS Inc. Windows is a trademark of Microsoft Corporation. Other
product and brand names are trademarks or registered trademarks of their respective companies.

Radio Frequency Interference and COMPATIBILITY

NOTE: This equipment has been tested and found to comply with the limits for EN55022 Class B:1998, EN55024:1998 of
CE Test Specifications. This equipment generates, uses, and can radiate radio frequency energy. If not installed and
used in accordance with the instruction, it may cause interference to radio communications. This device also complies
with Part 15 of class B of the FCC Rules. Operation is subject to the following two conditions: This device may not
cause harmful interference, and must accept any interference received, including interference that may cause
undesired operation.

Correspondence
For technical support inquiries, contact your nearest dealer or EGO SYSTEMS directly at:

Ego Systems Inc.

3003N. First St., Suite 303,

San Jose, CA 95134, USA
Website: www.audiotrak.net
E-mail: sales@audiotrak.net
Technical Support (English only)
techsupport@audiotrak.net

All features and specifications subject to change without notice.
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OVERVIEW

Enter a new world of home theater entertainment with the MAYA 7.1 surround sound audio
card. MAYA 7.1 provides two high-fidelity analog inputs and eight discrete analog multi-channel
outputs for Dolby Digital 5.1, EX, and DTS 5.1, ES for true surround sound and virtual surround
sound for 5.1, 6.1 and 7.1 speaker configurations.

When watching a DVD movie, MAYA 7.1 can supply a multi-channel surround sound environment
with a digital audio connection to a home theater system or from the multiple analog audio
outputs and a surround speaker system, resulting in audio reproduction the way the movie was
originally intended. For serious gamers, MAYA 7.1 offers the Sensaura 3D sound engine, which
supports of all the major game sound formats including DirectSound 3D, A3D 1.0, EAX 1.0, EAX
2.0, Macro FX, Environment FX, Multi Drive, Zoom FX, 13DL2, and more! Sounds will come from
every corner of the room with this enveloping audio technology.

Listening to and composing music will never be the same. With MAYA 7.1’s optical S/PDIF
output, 48 kHz digital audio data is sent directly to external devices such as Mini Discs. You can
even listen to MP3s and other stereo music in a 7.1 channel, virtual surround sound
environment using the included player software.

Compatibility isn’t an issue since MAYA 7.1's WDM driver supports all versions of Windows
including 98SE, ME, 2000, and XP, ensuring the same functionality under all operating systems.

MAYA 7.1 is the ideal solution for transforming your computer into a complete, multi-channel
Desktop Home Theater (DTHT) system.
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FEATURES

= Listen to 7.1 Channel Surround Sound on Your PC
=  Plug In with Analog Inputs (2) and Outputs (8) plus an Optical Digital Output
= Play DVDs, CDs, and MP3s in 7.1 Surround Sound with Included Software*

=  Emulate Multi-Channel Surround Sound with SRS TruSurround XT with Enhanced Bass
and Dialog*

= |Independent Surround Sound Channel Volume Control
= Optical Digital Output for MiniDisc Recorders and Portable Digital Devices
= Pass Pure Audio Signals to Dolby Digital and DTS Decoders

= Support Game Surround Sound APIs such as EAX 2.0 and A3D

* These functions will work only with the included WinDVD 4.0 software

MINIMUM SYSTEM REQUIREMENTS

= Intel Pentium Il 450 MHz CPU or equivalent AMD CPU
= Motherboard with Intel/VIA chipset

= 128MB of RAM

= One available PCI slot

= Microsoft Windows 98SE/ME/2000/XP operating system
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MAYA 7.1 PCl CARD

1. MIC IN (PINK): Connect to an external microphone for voice input.

2. LINE IN (BLUE): Connect to an external device (such as a Cassette, DAT, or Mini Disc player).

Caution: Inputting the line through the power amp can damage the card.

3. Front Out (GREEN): Connect to the front left and right speakers

4. Rear Out (BLACK): Connect to the rear left and right speakers

5. Center/LFE (ORANGE): Connect to the Center speaker and the Subwoofer

6. Center L/R (YELLOW): Connect to the Center Left/Right (Extra channel) speakers

7. Optical Out: TOS-Link Connect to a MiniDisc or external digital device for recording

Caution: Always keep the protective cover on when not using the optical cable. When
connecting the optical cable, never point the optical connector directly into your eyes, as the
light can cause eye damage.

8. AUX-IN: Connect to internal audio sources such as TV Card, MPEG, or other similar cards

9. CD-IN: Connect to the CD-ROM or DVD-ROM drive with a standard AC 97 design
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HARDWARE INSTALLATION

Before you begin the installation, please consult the manual of your computer for detailed
instructions on installing a PCI card in your computer.

1. Shut down the computer and all other hardware devices connected to your computer.
Leave the power cable attached to your computer, if you will be using the computer’s
power supply as the grounding outlet. Otherwise, unplug the power cord too.

< "l

o
o

2. Remove the computer’s main cover to expose the available PCI slot.

3. Ground yourself by touching a grounded metal surface (such as the power supply of the
computer). Ground yourself as often as necessary, especially after you’ve been
walking around a carpeted room. Read and follow the instructions on “Handling
Electronic Devices” if you haven’t already done so.
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4. Choose an available PCI slot and remove the cover plate (and the screw that holds it in
place) from the slot on the back of the computer.

5. Before handling the MAYA 7.1 PCI card, make sure once again that you are properly
grounded then remove the card from its protective envelope.

6. Align the MAYA 7.1 PCI card with the selected PCI slot.

7. Press the card gently but firmly into the slot until the connector is fully inserted. Don’t
force the card into the slot and never bend it in any way. If the card isn’t snugly fit,
pull the card out and try it again.

8. Using the screw removed from Step 4, screw it back onto the card to keep it from
moving. It must be tightly and firmly screwed on.

9. After the card is installed, replace the computer’s main cover.

10. with the card installed, you may proceed with the speaker and software installation.
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SPEAKER INSTALLATION

There are many types of speakers for various multimedia systems. This section lists the settings
for various speaker configurations.

1) Connecting regular stereo speakers

If you have general stereo PC speaker, just connect to Front Out (green color).

2) Speaker configuration of Dolby Laboratories Inc.

. Laeft  Conter Right . Left  Center Right .l.un Canter Right
Sub Sub [ Sub [ |

A5°— 60" A5"— 60°
[ I ﬁ W N a [ |
Leoft Laft Right | | Laft Right
surround surrsund surround surmround surround

80— ag*
= Laft back
Back surround surround N.uﬂr:'ln m
5.1 playback 6.1 playback 7.1 playback

3) Speaker configuration of Micro Soft Inc.
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DRIVER AND SOFTWARE INSTALLATION

After completing the installation of hardware and speakers for the MAYA 7.1, you should install
the MAYA 7.1 driver software.

Note: The motherboard, which utilizes a new chipset, may need a patch installed. The patch
should be available from the motherboard company or chipset manufacturer.

Check the manufacturer and model number of the chipset of your motherboard and then
download patch from one of the following links:

http://support.intel.com/support/chipsets/

http://www.amd.com/support/software.html

http://www.viatech.com/jsp/en/dr/driver.jsp

The installation steps for Windows 98SE, Windows Me, Windows 2000 and XP are slightly
different. The following installation example is performed under Windows XP.

1. Turn on your computer. Windows will automatically detect that a new card has been
installed and the “Found New Hardware Wizard” will appear.

2. Choose Install from a list or specific location and click Next.

Found New Hardware Wizard
Welcome to the Found New
Hardware Wizard

This wizard helps you install software for:

Maya 7.1 EWDM Controler By AUDIOTRAK.

Z;'J If your hardware came with an installation CD
2 or floppy dizk. insert it now.

Wihat do you want the wizard to do?

() Install the software automatically [Fecommended)
(&ilnstall rom a hist or specitic locabon (Advanced)

Click Mext bo continie.

Mest » I [ Cancel
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3. Choose “Search for the best driver in these locations’, and then select ‘Include this
location in the search”. Insert the AUDIOTRAK Installation CD into the CD-ROM drive.
Click the Browse button to locate the CD directory listed in the following image. Once
you have located the directory, click Next to continue.

Found New Har.dware Wizard

Pleaze choose your zearch and installation options.

() Search for the best driver in these locations.,

Uze the check boxes below to limit or expand the default zearch, which includes local
paths and removable media. The best driver found will be installed.

[ 5earch removable media (floppy. CO-ROM...]
Include this location in the zearch;

D:ADATSDRIVERSMAT AT a2 w| [ Browse

() Don't search. | will choose the driver to install.

Chooze thiz option to select the device driver from a list. “Windows does not guarantee that
the driver you chooze will be the best match for your hardware,

[ < Back " MHest » l[ Cancel ]

4. Ignore the following message and click Continue Anyway.

Hardware Installation

L} E The software you are installing for this hardware:
e
Maya 7.1 EWDM Controler By AUDIOTRAK,

haz not paszed Windows Logo testing to verify its compatibility
with YWindows =P, [Tell me why thiz testing is important. |

Continuing your installation of thiz software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for zoftware that has
passed Windows Logo testing.

Cartinue Anyway ] [ STOP Installation |
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Windows will begin copying the files to your computer.

Found New Har.dware Wizard

Pleaze wait while the wizard installs the software_.. e

@ tapa 7.1 Ew DM Contraler By ALDIOTRAK
)

portcls sps
To C:AWINDOWS system32\drivers

5. When Windows finished copying the files, the ‘Completing the Found New Hardware
Wizard” window will appear. Click Finish to continue to the next step of the installation.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard haz finished instaling the software for:

@ tdava 7.1 EWDM Controler By ALDIOTRAE,
2

Click Fimizh to cloge the wizard.

Finizh
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6. Windows will automatically continue with the installation. The following window will

appear. Click Next.

Found New Hardware Wizard
Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install software for;

MIDITRAK 2120 By AUDIOTRAK

Z;') If your hardware came with an ingtallation CD
xa'g:'-" of floppy dizk. inzert it now.

What do you want the wizard to do?

() Install the software automatically [Fecommended)
(®)nstall from a list or specific location [Advanced}

Click Mext to continue.

I Mext » l[ Cancel ]

7. Ignore the following message and click Continue Anyway.

Hardware Installation

L) E The zoftware you are installing for this hardware:
*
MIDITRAK 2120 By ALUDIDTRAK

haz not paszed Windows Logo testing to verify its compatibility
with WWindows =P, [Tell me why thiz testing is important, |

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for zoftware that has
passed Windows Logo testing.

Cartinue Anyway ] [ STOP Installation |
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8. When Windows finished copying the files, the ‘Completing the Found New Hardware
Wizard’ window will appear. Click Finish to continue to the next step of the
installation.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard haz finizhed instaling the software for:

@ MIDITRAK 2120 By AUDIOTRAK
2

Click Finizh to close the wizard.

9. Windows will automatically continue with the installation. The following window will
appear. Click Next.

Found New Har dware Wizard

Welcome to the Found New
Hardware Wizard

This wizard helps you install software for:

Maya 7.1 EWDM Wave

Z;') If your hardware came with an installation CD

“Zg or Hloppy disk. insert it now.
Wihat do you want the wizard to do?

() Install the software automatically [Fecommended)
(&yilnstall from a hist or specitic locabon (Advanced)

Click Mext bo continie.

Mest = l [ Cancel
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10. Ignore the following message and click Continue Anyway.

Hardware Installation

L) E The zoftware you are installing for this hardware:
-
Mapa 7.1 EWDM Wave

haz not pasged Windows Logo testing to verify ite compatibility
with WWindows =P, [Tell me whey this testing is important. |

Continuing your installation of thiz software may impair
or destabilize the correct operation of your system
either inmediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Aryway l | STOP Installation |

Windows will begin copying the files to your computer.

Found Mew Hardware Wizard

Pleaze wait while the wizard installs the software. ..

@ Maya 7.1 EwWDM Wave
S

drmnk.sys
To CAWINDOWS eystem32\drivers
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11. When Windows finished copying the files, the ‘Completing the Found New Hardware
Wizard” window will appear. Click Finish. The installation is now complete.

Found New Har.dware Wizard

Completing the Found New
Hardware Wizard

The wizard has finiched instaling the software for:

@ Maya 7.1 EWDM Wave
%)

Click Finizh to close the wizard.

12. Restart your computer.
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13. After rebooting, Go to ‘My Computer -> Control Panel -> System -> Device Manager’.
Check the devices under ‘Sound, video and game controllers’. You should see the
following new devices:

Maya 7.1 EWDM Controller by AUDIOTRAK
Maya 7.1 EWDM Wave
MIDITRAK 2120 by AUDIOTRAK

Device Manager

File  Action Miew Help

m & 2 &

-J Zompuker
g Disk drives
é Display adapkers
Lh DVDICD-ROM drives
=) Floppy disk cantrallers
\‘g Floppy disk drives
=% IDE ATA[ATAPT conkrallers
= Kevboards
'_) Mice and other poinking devices
E,. Moderns
+ § Manitars
+-EE) Netwark adapters
+- 5 Ports (COM & LPT)
+-#8% Processors
- 9,/ Sound, video and game controllers
@,/ Audio Codecs
@), Legacy Audio Drivers
9,, Legacy Yideo Capture Devices
9,, Maya 7.1 EWDM Conkroler By AUDIOTRAK
@), Maya 7.1 EWDM Wave
@,/ Media Control Devices
9,/ MIDITRAK 2120 By AUDIOTR.AK
@), MPU-401 Compatible MIDI Device
@), standard Game Port
9,/ Video Codecs

+- ¢ System devices
+ Universal Serial Bus controllars

+-F- - E- - - - E -
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CONTROL PANEL

After successfully installing the MAYA 7.1 PCI card and software, the AUDIOTRAK logo will
appear in the system tray. Click on the AUDIOTRAK logo to launch the MAYA 7.1 Control Panel.

a Maya 7.1 v4.0 - Console

Fil=  Config
Line Iz AL D ECor o2 Qw34 OutSE  OutTs
= I
oo oo oo oo oo -3.0 -3.0 =30 =30 =30
[ mute | mute | mote | mute | [ mute | [ mute | mute | mute | mute | [ mute |

FILE - EXIT

File -> Exit will close the MAYA 7.1 Control Panel window but it will not shut down the Control
Panel. You can launch the Control Panel by clicking on the AUDIOTRAK icon in the system tray.

CONFIG - MOUSE WHEEL

Config -> Mouse Wheel will control the mouse wheel adjustment. When you use the mouse
wheel to adjust the volume level, the adjustment step is set to +1.5dB. You can configure the
adjustment steps to your preference.

- Step 1: When you move the mouse wheel one step, the fader will move by +1.5dB.

- Step 2: When you move the mouse wheel one step, the fader will move by +3.0dB.

- Step 4: When you move the mouse wheel one step, the fader will move by +6.0dB.

- Step 8: When you move the mouse wheel one step, the fader will move by +12.0dB.
CONFIG - LATENCY

Sets the latency of the MAYA 7.1. The MAYA 7.1 provides four different sample buffer sizes - 64
sample ~ 2048 sample. You must close your audio applications before changing the latency.
When watching a DVD movie, we recommend setting the latency to 1024. However when you
use the MAYA 7.1 for hard disk recording or with a MIDI sequencer program, we recommend
setting the latency to 512.
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IF you are using Sonar, you should click ‘Wave Profiler’ again after changing the latency.
Changing the latency affects all applications.

CONFIG - FACTORY DEFAULT
Returns all MAYA 7.1 Control Panel settings to the original shipping state.
CONFIG - ALWAYS ON TopP

Keeps the MAYA 7.1 Control Panel on top of all open windows. This is useful when working with
multiple music applications simultaneously.

MAPPER

When you set the ‘Stereo-PCM, SPDIF, AC3’ driver in the Windows audio setting, you may
choose the output port for the stereo wave file in the Mapper menu. You may choose to send
the stereo wave file to Out 1,2, Out 3,4, Out 5,6 or Out 7,8. When you use the AC3, DTS
decoder through the Optical output, you should choose “Out 1,2(SPDIF/AC3)”.

INPUT MIXER

Lire Al

0.0 0.0 o0 0.0
[ mute | muete | mute | mute |

This section of the Control Panel adjusts the Input levels of each device. The MIC input defaults
to a 20dB boost with Mute turned on.

If you are not using an input, you should select Mute under that input.
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RECORDING MIXER

The Recording Mixer adjusts only the recording level of the inputs. Selecting MIX adjusts all
recording levels. You can also change the levels of the LINE, MIC, AUX, CD individually by
clicking on the MIX button until the preferred input name is displayed.

WAVE MIXER AND MASTER VOLUME

The Wave Mixer and Master Volume control the output levels of each channel. The channels
can be adjusted individually or the overall volume can be adjusted using the Master level
control.
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WORKING WITH APPLICATIONS

* This chapter only contains the basic setup for some of the software. For more detailed
information, please refer to the manual of the software.

WIN DVD

The MAYA 7.1 can playback 5.1, 6.1, or 7.1 audio when used in conjunction with the WinDVD
software player.

NOTE: To produce crisp DVD video playback, ensure that DMA is selected on the DVD-ROM drive
in the Device Manager.

Select Volume and click ‘Advanced’ on speaker settings. Select ‘Advanced Audio Properties’
and choose ‘7.1 Surround Speakers’.

Advanced Audio Properties

Speakers | Perfomarice

\"y Select the zpeaker zetup that iz most like the setup you have
O pour computer,

(ad
* e

Speaker zetup:

7.1 zumound zound speakers w |

(0] 4 H Cancel ][ Apply
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In the WinDVD main Window, click the right mouse button, and choose ‘Setup.’

Select ‘8 Speaker Output’. Now you can enjoy DVD with 5.1-, 6.1- or 7.1-channel surround
sound.

Setup §|

Preferences | Control | Audio | Video | Fegion | Information
Adio Dutput Configuration

{(*) Analog Sound Card [] Esternal Pro Logic Processor
(73 Digital [S/PDIF] out to External Processor

Audio Speaker Configuration

{73 2 Channel [Front L/R or Headphone]

{7 4 Channel [Front L/R and Surmound LR
{73 6 Channel (5.1 Home Theater]

{7 7 Channel [6.1 Home Theater]

(%) & Chanrel [7.1 Home Theater] TEST

[*]i5end 0.1 [LFE Subwoofer] to Speakers/Headphones

I (] l[ Cancel ][ Apply ]

* For more detailed information, features and operation, please refer to the ‘Help’ menu of the
software.

Ref. Dolby prologic decoder in Power DVD 3.0 and Win DVD 2.3:

This is an optional function for a DVD title that isn’t recorded with Dolby-Digital. You may
select it if sound is not heard when watching a DVD movie.

Ref. AC-3/DTS Pass Thru at Power DVD 3.0 and Win DVD 2.3:

You can connect the MAYA 7.1 to an A/V receiver with an optical cable. The AC-3/DTS pass
thru feature is only available in ME/2000/XP.
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MAVEN 3D PRO - EMERSYS

After launching Maven 3D Pro, Go to “‘Option’ -> Audio Device Setup and choose the settings as
shown in the diagram below. You can use both WDM and ASIO drivers with Maven 3D Pro.

This program is 5.1 channel surround sound software.

Audio Device Setup x|

% Wave out uzing extensible wave format

™ Custom zetting

L I Mare j I Left j

B I Maone j I R ighlj
[ INu:une j ILeft j
W I Mare j I R ighlj

Ls INDHE j ILeftj
Fs INu:une j IHighlj

" 2sI0
AS510 Drrivers A510 Clock Source
[451020-Mapa 71 x| [MAYATI Clock =l

ASI0 Control Panel |

Cutput Channel Route ; IMDI:IE 4 L/R.CA. Ls/Rs= j
YWindows Default Miser ; Open windows miser... |
] LCancel |

* For more detailed info and operation, please refer to the ‘Help’ menu of the software.
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NTRACK STubiO -FARSOFT

After launching nTrack, go to Files -> Settings -> Preference -> Audio Devices.

When Wave devices menu appear, select * WDM:2-Maya7.1 Multi channel’.

WAYE devices

Audio plavback devices

Audio recording devices

ASIO 20 -Mapa 71

ASIO 2.0 -WSL2020

ASIO Directs Full Duples Drver

ASIO Multimedia Driver

MME: 1-bapa 7.1 Sterea-pom, zpdif ac3
MME: 2-baya 7.7 Multi Channel

MME: "W ave Mapper

WO 1-kaya 7.1 Stereo-pom,spdif, ac3

d: 2-baya 7.1 Multi Channel

Advanced |

ASIO20-Mapa 7.l

ASIO 2.0 -wS5L2020

ASIO Directs Full Duples Drver

ASI0 Multimedia Diriver

MME: 1-Mapa 7.1 Sterec-pom, spdif,ac3
MME: 2-Maya 7.7 bulti Channel

MME: " ave Mapper

WD 1-Mapa 7.1 Stereo-pom,zpdif ac3
1 -'WDk: 2-Mapa 7.1 Multi Channel

Dirag or hold dovwn the CTRL key to zelect multiple input andAor output devices.

Help | | Cancel

You can also use MME and Direct Sound driver with nTrack.

After click ‘Advanced tab’ on “Wave Devices’ menu, you can choose the proper driver.
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Wave devices advanced sekEi 5[

v i :
¥ Show'wDM devices

¥ Show Asio devices

¥ Show DirectSound devices

Compenzation: IEI

WOMAASIO Multichannel———————
Jze up to I'IE output channelz

|lze up ta I'I G input channels

v Eeep audio devices open
Resync if off by more than |5 ms

Help | ] I Eancell

* Caution: nTrack and MAYA 7.1 working with 48kHz audio source.

If you use 44.1kHz audio source, you may get an error message.

Recording settings I Dptiu:ur'ml Appearancel MIDI $ettings| Paths I
Sampling frequency [Hzl————
€ BO000 ¢ 32000 ¢ 88200

11025 44100 ¢ 95000
" 22050 % @S00C ¢ 152000

" Custom; |4SDDD

Stereo or mono recording and the number of bitz used for
each zoundcard are et via the 'Settings’ buttons in the
recording and playback vumeter windows .

Audio devices Buffering

t asimum rumber of tolerated plavback buffer underuns: IE

Hide lag indicator if lag magnitude less than: I"I

Rewvert preferences to the default sethings |

Ok I Cancel Help

® For more detailed info, please refer to the Help file of the software.
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SPECIFICATIONS

= Input Type: Analog 2 Input - Line-In (3.5mm Jack), Mic-In (3.5mm Jack) Aux-In, CD-In
= Output Type: Analog 8 Output (3.5mm Jack), SPDIF_Out (TOSLINK)

= |nput LEVEL: -10dBV Unbalanced, -10dBV Nominal, +9dBV Max

=  Qutput LEVEL: -10dBV Unbalanced, -10dBV Nominal, 0dBV Max

= Input Impedance: Mic in 47K ohm, Line in 10K ohm

=  Qutput Impedance: Output 1,2 : 700 ohm, Output 3,4, 5,6, 7,8: 100 ohm
= IN 1,2 Record Gain: Analog 0dB ~ 22.5dB, 1.5dB Step Size

= |nput Monitor Gain: Analog -34.5dB ~ 12dB, 1.5dB Step Size

= Qutput Attenuation: Analog -46.5dB ~ 0dB, 1.5dB Step Size

= Sample Rate: 48KHz

= A/D Spec

0 Resolution: 18 bits
o Dynamic Range (S/N): 86 dB A-Weighted (Typical)
o0 Frequency Response: 20 ~ 20KHz

= D/A Spec

o Resolution: 18 Bits

o Dynamic Range (S/N): 96dB A-Weighted (Typical-1,2CH),88dB A-Weighted
(Typical-3,4,5,6,7,8CH)

o0 Frequency Response: 20 ~ 20KHz
= Digital Out Spec

o0 Type: Optical connector (TOSLINK)
o Format: IEC-958 Consumer, S/PDIF
o0 Sample Rate: 48KHz

0 Resolution: 16 Bits

=  Mic PreAmp Spec

0 Mic Input Gain: +20dB Fix and +20dB on/off and -34.5dB ~ 12dB Variable

o0 Phantom Power: +4V Phantom Power, Multimedia Mic Support
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